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There is now only one application development product sold by IBM, for iSeries, as of V4R5.
This is WebSphere Development Studio (Development Studio), which includes all four host
compilers, all traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and
unlimited licenses of the workstation-based toolset named WebSphere Development Studio
Client (formerly WebSphere Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development
Studio free of charge. Without a Software Subscription, there is an upgrade fee. New licenses
of Development Studio are priced very competitive compared to the combined prices of all
constituent products. As of V5R1, there is no way to purchase the compilers or tools
individually. So if you have RPG at V5R1 or higher, you must have Development Studio and
hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can
be purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have
all the modern Application Development tools from IBM. This ubiquity is especially important
for business partners who build and sell software. These Business Partners are now free to
build software using any of the technologies or tools in Development Studio, and can assume
their customers will have the tools required to tailor everything from RPG to Java and Web
user interfaces. This effectively raises the lowest common denominator to a level unparalleled
by any other operating system.
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There is now only one application development product sold by IBM, for iSeries, as of V4R5.
This is WebSphere Development Studio (Development Studio), which includes all four host
compilers, all traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and
unlimited licenses of the workstation-based toolset named WebSphere Development Studio
Client (formerly WebSphere Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development
Studio free of charge. Without a Software Subscription, there is an upgrade fee. New licenses
of Development Studio are priced very competitive compared to the combined prices of all
constituent products. As of V5R1, there is no way to purchase the compilers or tools
individually. So if you have RPG at V5R1 or higher, you must have Development Studio and
hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can
be purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have
all the modern Application Development tools from IBM. This ubiquity is especially important
for business partners who build and sell software. These Business Partners are now free to
build software using any of the technologies or tools in Development Studio, and can assume
their customers will have the tools required to tailor everything from RPG to Java and Web
user interfaces. This effectively raises the lowest common denominator to a level unparalleled
by any other operating system.



‘ IBM Software Group | WebSphere software

Table of contents

& Customizing Workbench and Editor
User Actions and Compile Commands
Running Interactive Commands in RSE
RSE Filters and Filter pools
Working Disconnected

iSeries Projects

mu. i, 1—
4 Remote System Explorer | Advanced © 2005 IBM Corporation

Agenda




‘ IBM Software Group | WebSphere software

The Remote System Explorer Perspective
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This is the familiar default appearance of the Remote System Explorer

Perspective.
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The Remote System Explorer Perspective can be customized to look like this.
The editor takes up most of the space, now. It appearance has been changed.

The iSeries Table view resides below the editor and all other views have been
either closed or moved to the left margin as fast views.
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Customizing the Workbench

» Customize Perspective
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Perspectives can be modified to fit your work style. Move, re-size or close
existing views. Open other views that you want to add to the perspective.
Save the customized layout as a new perspective using Window -> Save
Perspective as.

Settings for your own perspectives as well as the ones shipped with the
product, can be maintained from Window -> Preferences, expand Workbench
and select the Perspectives page.
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There are two places in the preferences that allow editor customization: LPEX
Editor and Remote Systems, iSeries, LPEX Editor Parsers.

Besides appearance i.e. colour settings, the editor behaviour can also be
modified.

Examples are syntax checking and column sensitive editing.
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RSE: User Actions

» User-Defined Actions ... like PDM!
— Right-click on iSeries Objects -> Work With

— User Actions
— Create, delete or change user-defined actions
— Scope them so you only see them when appropriate

— Named Types
— Create named types to scope actions against
— EG. “RPG” might be RPG + RPGLE + SQLRPGLE

= ... and even beyond PDM!

- Create user actions for libs/objects, members ... and even jobs
and IFS folders and files!

1 7 Al
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While IBM supplies a number of useful actions for remote iSeries objects, it is
not possible to supply them all. Like PDM, you can easily define your own
actions. To create your own actions, use the Work With actions in the popup
menu for iSeries Objects. These user-defined actions will appear in the popup
menus for remote resources. To avoid seeing all actions in all popup menus,
you scope each action to one or more object or member types. You first define
named collections of object or member types, then you create your actions
and scope them to one of these named collections of types. You actions will
then only appear for object or members that match one of the types in the
collection. These actions can be created for objects, members, jobs and IFS
folders and files.
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Use Work With -> User Actions to define an object or member action. Object
actions only appear in the popup menus for libraries or objects. Member
actions only appear in the popup menus for members. When you define the
action, you initially specify a label to show in the popup menu and an iSeries
command to run when that action is selected. This command can use
substitution variables that are identical to those in PDM. There are also
numerous options you can specify to affect the action, and you can scope it
precisely: for example, object actions can be scoped one or more type and
attribute pairs, and member actions by one or more simple or generic member
types.
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Substitution Variables

= Many substitution variables
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All PDM substitution variables are supported for the command, and some new
ones that PDM didn’t support.

When you type &, you see a popup selection list, or you can type Ctrl+Space
or press the Insert Variables button. From the list, double click to insert the
selected variable, at the cursor position.
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Once your action is defined, you can use it. Right click on an object matching
one of the types you specified, and expand the User Actions menu in the pop-
up. Your action appears in the menu. Select it. If you chose to prompt the
command (via the Prompt option), you will see the GUI prompt for the
command. When the command has finished running, it results are logged in
the Commands view.
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User Actions for Jobs
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You can also create user actions for Jobs, which will appear in the User
Actions popup menu for jobs in the iSeries Jobs subsystem under a
connection. The substitution variables include variables for the selected job’s
number, user and name.
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You can also create user actions for IFS folders and files, which appear in the
User Actions popup menu for folders and files in the IFS Files subsystem
under a connection.

You can create user actions that are QShell commands or *CMD objects as
usual. The substitution variables change depending on the type of command:
for gsys commands you get the PDM substitution variables, slightly different to
deal with folder/file names versus object/member names. For gshell
commands, you get a different list using eclipse-style ${...} variables, with
many variables for all aspects of the selected folder/file name, but a number of
other environment variables.

Note the gshell-support is the same as when creating local, unix, windows or
linux user actions, which are also supported.

15
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Running User Actions for IFS
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IFS user actions show up in the right click of the IFS files or folders, as shown
here. If the action is defined to prompt, then you get a prompt dialog where
you can edit the command before submitting it.
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Work With Compile Commands
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In additional to user actions, there is specific support for creating compile
commands too. Use the Work With -> Compile Commands option from the
iSeries Objects subsystem under an iSeries connection. IBM pre-supplies
compile commands, and enables vendors to pre-supply commands as well,
some of which do.

17
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In the Work With Compile Commands dialog, you can create new compile
commands and edit existing ones. To edit an existing one, first find it by
selecting the member type it applies to (or add a new member type if
necessary) at the top of the dialog, and selecting the command in the list of
commands on the left. Then edit the command and press Apply. You can also
right-click on a command to delete it, copy/paste it, or re-order it. Note you
cannot delete IBM-supplied commands, but after editing them, you can restore
them to their shipped value.

18
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Creating New Compile Command
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To create a new compile command, select “New command” on the left, and
then enter the label to show, and command to run, and press Create. The
command will show up on the list on the left, and will also now be available at
runtime, as we see on the next slide...
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Running New Compile Command
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B RMF2120  External descriptions for file MSTDSP not Found; file isignored, 40 27 CODELAB/QRPGLESRC(PAYROLLG) My iSeries
B RMWF2120  External descriptions for file PRIMST not found; file is ignored. 40 28 CODELAB/QRPGLESRC(PAYROLLG) My iSeties
B RMF2120  External descriptions For file RSNMST not found; file is ignored. 40 30 CODELAB/QRPGLESRC(PAYROLLG) My iSeries
[l RWF7030  The name or indicator ACODE is not defined, 30 103 CODELAB/QRPGLESRC(PAYROLLG) My iSeries
Ll RMF7030  The name or indicator EMPAPL is not defined, 30 54 CODELAB/QRPGLESRC(PAYROLLG) My iSeries
Ol RMF7030  The name or indicatoer PRCDE is not defined. 30 257 CODELAB/QRPGLESRC(PAYROLLG) My iSeties
[l RNF7030  The name or indicator PRCMP is not defined. 30 264 CODELAB/QRPGLESRC(PAYROLLG) My iSeries v
Remote System Details | Tasks |iSeties Table View iSeries Commands Log | iSeties Errar List | Remate Commands
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Here we see our new compile command appearing when we right click on a
member of the type we created the command for. Note the checkmark
appears beside the last-used compile command for the selected member’s
type. When the compile command runs, if it generates an event file that event
file is automatically retrieved and the errors produced by the compile are
displayed in the Error List window, where you can double click to open the
editor and position it at the error.
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Defining IFS Compile Commands

= Yes, you can even create compile commands for IFS
files ... and even local, Unix, Windows and Linux!

4P Work With Compile Commands

Shell cornmand hd

Parent profie: [Philcoukhard ~ | El
051400 command

Source bype: java ~ | Add..

Compile Commands:

Selected compile command: &FCM - Name of parent folder containing selected file or Folder
My command

&FCP - Fully qualified path of parent folder, including name of sele
Label: ‘ &FME - Extension part of the name of the selected file
&FHR, - Name of selected file without the extension
&FP - Fully qualified path of selected file or Folder, including name
&l - Name of selected file or folder
&0 - Ohject library, From Command Execution properties
&R - Replace object when compiling, *YES or *MO, Fram Comman,

Command: ‘Qshell cammand

svar -deprecation -classpath . ${resource_name}

Insert variable, .

i

${container_path} - Path of folder containing selected resource, including name
${resource_name_root} - Name of selected resource without the extension
${resource_name} - Mame of selected resource, ungqualfied
${resource_path_drive} - Drive letter on Windows, empty string on others
f{resource_path_root} - Rook of selected file's path. "c:\" on Windows, ar *j" on athers
${resource_path} - Path of selected resource, including name

${system_filasep} - File separator, "\" on Windows, "f" on Unix and Linux
${system_homedir} - Home directary on the target system, For the connection’s user 1D

${system_pathsep} - Path separator, "}" on Windows, ™" on Unix and Linus
1 ${system_tempdir} - Temparary direckory on the target system
4

Remote System Explorer | Advanced

© 2005 IBM Corporation
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Running IFS Compile Commands

Ems B b
\ New Ci i
: g L:cv‘:‘ ‘onnection o To R
4P Prompt Compile Command
w0 Linux Open With 3
= &I My iSeries Browse With » Optianally edit the command before running it. Press Run to run ik,
+ @iy iSeries Objects
+ @k iseries Commands &5 Refresh
! @ iSeries Jobs Compile command
= Mo IS Hles javar ~depracation -dasspath . ArcTest java
#- 5 File systems
+ I Root file system 1 Rename
Ed
+-5p Home L oy
= :%5:> My Falder Py
I 5 test b Mave
== ArcTest 2 Delete Run Cancel
ArcCanvas.class
ArcControls.class 4
ArcTest.class )y
cTest javs 3
B examplet. html - (5 work with Compile Commands...
(] chest Compare With — »
(] servertest Replace With  »
* &' TORASIFE Properties

A 4 A
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Here we see our new compile command appearing when we right click on an
IFS file of the type we created the command for. Note the checkmark appears
beside the last-used compile command for the selected file’s type. When an
0OS/400 compile command runs, if it generates an event file that event file is
automatically retrieved and the errors produced by the compile are displayed
in the Error List window, where you can double click to open the editor and
position it at the error. When a QShell compile command runs, the errors are
shown in the Command view, and are double clickable.
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Preferences For User Actions and Compile Cmds
ol

Window->
Preferences

Specify
preferences
here, for all
connections

Override per
connection via
Properties
dialog for
iSeries Objects

- Crystal Reports Yiewers = |

-Data

- Help

- Instal/Update

(- Internet

[#]-iSeries Projects

- J2EE

(- dava

[ LPEX Editor

(- Modeling

Process

=1 Remote Systems

Communications

[ Debug
File Cache

~Files

El- iSeries
i Cache
+Command Executio
+Command Subsyste
+--Job Subsystems
LPEX Editor Parsers
- Objects
Program Werifiers
o Table Yiew
o Templakes

- Logging
Passwords

- Run/Debug

(- Server

single Sign-on

(- walidation

B web and XML

[]-Web Diagram

- WebFacing

(- e Tools

Ll

o

<ommand Execution Preferences

Preferences for compiles and user action variables

| Command Execution ‘
§ &0 var

bject library: SRCLIB -

¥ Replace object &R Var

' Compile in batch &P var

Preferences for batch compiles, commands, and user action varisbles &H Va.r
Job description library: +LIBL >

30b description: l &G var rLISRPRF =1

SBMIOE additional parameters:
&ISJ var

™ Add batch compiles to the iSeries Job Status view
™ Add hateh commands to the iSeries Job Status view

Preferences only for compile commands

Compile member types in this order:

Mo U I

RPGLE Iewe Dt I
CLLE =l

Preferences only for user action variables

™ Runinbatch

Restore Defaulks apply

Al
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There is a preferences dialog that has many preferences which affect
substitution variables for user actions and compile commands.
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4 Preferences

Preferences For User Actions and Compile Cmds

Window->
Preferences | |= voribencn a
&1 Agent Controlier
+-Ant
Build Order
+ Component Test
#-Data
0 =+l Debug
Specify 4 Hep
+- InstallfUpdate
preferences bl
here, for a” 1 i5eries Prajects
H J2EE
connections - Java
Lagging
. +I- LPEX Editar
Overnde per /- Plug-In Development
. . =+ Profiling and Logging
connection via - R
1 = Remote Systems
Propertles Cammunications
dialog for Fiec
H H H = iSeries
iSeries Objects e
Command Subsyste
Job Subsystems
#I- LPEX Editor Parsers
Objects
+I- Program Yerifisrs
Templates
Logaing
Passwords
+- Gerver ha
< >
24 Remote Sydic.ii cnpvivr | ruvaioon

Command Execution

‘Command Execution Preferences

Freferences For compiles and user action variables &O var
Object lbrary: *SRCLIE -

[v Replace object
W Compile in batch

Preferences for hatch compiles, commands, and user action variables
var

Job description library: ’—-:I

Job description: &G var |[uer -

SEMICE additional parameters: &ISJ Var

Preferences only for compile commands

Zompile member types in this order:

Preferences only for user action variables

I Runin batch &E var
Restore Defaults Apply
g% poration

There is a preferences dialog that has many preferences which affect
substitution variables for user actions and compile commands.

24
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Table of contents

Customizing Workbench and Editor

User Actions and Compile Commands
+&Running Interactive Commands in RSE

RSE Filters and Filter pools

Working Disconnected

iSeries Projects

\ r 3
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Running Interactive Commands in RSE

There are three types of iSeries commands in RSE
Normal -> runs in RSE batch job (with adopted user ID)
Batch -> runs via SBMJOB (using preferences for JobD, etc)
Interactive -> runs in interactive job (you must do STRRSESVR)
You will see this prompt in many places. Eg:
When defining User Actions
When defining Compile Commands
When running commands in iSeries Command log view

4P Work With User Actions

Parent profile: ‘Ph\\Cou\thard

[<]
=By e Action name: Add to Library List
% Obiject action
2 Member action Corment: &dd selected library ta lip ist
= & Object
(% Add to Library List

=@y Member
(14 Prink with SEU

Command: Mormal command

Mo nd
Batch commar
Interactive command

Select in what job the command will run, Press F1 Far details,
T

vl
26
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Within the Remote System Explorer, there are 3 ways to run commands on
the iSeries: normal, batch or interactive, as described here. You will see the
prompt for the three types of commands throughout the RSE, so its important
to know the differences between them.
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Running Interactive Commands in RSE

» Step 1: Run STRRSESVR in any emulator

= Sassion A - [24 x BO]

Fle Edit View Communication Actions Window Help

AL b [ a8 & The profile-qualified
RVER [STRRSESUR) RSE connection name
to associate this
interactive session
with

Where to put user
- value, #PRY, *DFT Space for history

Host name of your PC

i .i, ‘—
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To run interactive commands, you must run the STRRSESVR command from
within an emulator. Specify the name of the connection within the RSE to
associate this interactive session with ... qualified by profile. It may help to
select the “Qualify connection names” option in the dropdown of the title bar of
the Remote Systems view in the RSE, so you can see what profile your
connection is in. Also specify a library unique to you, to hold *PRV values for
this command, and of course your PC’s hostname or IP address.
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Running Interactive Commands in RSE
= Step 1: Emulator is now reserved...

=iSassion A - [24 x BO]

Fle Edt Yew Communication Actions Window Help

B A% @@ = %% 2 &l ele

I6M Communicatio FWER

Connection Mame: PhilCoulthard.My iS

(c) Copyright IBM corp.,
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When the STRRSESVR command is successful, it will reserve the emulator
by putting up the screen shown here.
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Running Interactive Commands in RSE
» Step 2: Run interactive command in RSE

WL iSeries Commands Lag g - x

My iSeries 1

ADDLIELE LIE{CODELAE) -~
Library CODELAE added to library list, i
Cause . ... . i If the ADDLIBLE command was used, CODELAB was added to the user library list, IF the CHGSYSLIBL
command was used, CODELAR was added to the system portion of the library list.

v

Command |Interactive | [sTRPOM =] Prompt,., | Run

Remote System Details | Tasks |iSeries Table Wiew |iSeries Commands Log |iSeries Error List

WL iSeries Commands Lag \ g - x

My iSeries 1

STRFDM -~
Command STRPDM has been senk ko the interactive job, Switch to the emulator where the STRRSESYR. command is running
For this connection

~
Command |Interactive | -]

Remote System Details | Tasks |iSeries Table Wiew |iSeries Commands Log |iSeries Error List

: m “ il
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Now, within the connection associated with the STRRSESVR command, you
can run interactive commands from within the RSE, and debug interactive
programs. The example here shows running STRPDM from the iSeries
command log view. You need to give focus to your reserved emulator to see
the results...

29
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Running Interactive Commands in RSE

» Step 2: ... and your command runs in emulator:

= Sassion A - [24 x BO]

ment Manager (PDM]

:fined options

30 Remote System Explorer | Advanced

© 2005 IBM Corporation

... and here we see that the reserved emulator is now running the interactive
command we entered in the RSE.

30
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Run: from popup menus
| Remote 5 v x
Run from Popup £
[l New Connection o »
f * PG M Local —
m e n u o -8 My server [ show in Table
. . . =1 iSeries Objects —
/ I S e rl eS a | I n T work with libraries. .. G Refresh
p p . -7 work with objects. . Expand
. &2 Work with members. .. Callapse
R S E J O b il Library list
Wl Qsvsza24.Mb.prod-sy: @i Rename
Wil qs¥s Hib.prod-sys
\/ B atC h Ml G5¥s2.%ib,prod-sys S
Wil QHLPSYS #ib.prod-sys I pacte
/ H i, QUSRSYS *ib. prod-sys &y Mave
I nte ractlve I, QGPL ¥ib prod-usr
i, QTEMP. b test-usr % Delete
/ M | 1 h d =l RSELABO4.Mib prodeust g
U tl 't rea e CLCL *pgm.clle Change.
CLRL.*pgm.clle Save.‘.m
MYCOMPILE.*pgm. 2
LIS User Actions »
PAYROLLD. *pgrck =70 700
R u n As GSTURGsl: Service Entry Point
COMPARE. *file. pf-< iSeries application in RSE Job
EMMST.*file.pf-0t =g, riprompt)(F) > Batch
EVFEVENT file.pft b o) D
¥
, m;gzgziﬁ:ng Debug (Prompt)(K) > Multi-threaded
= onoenene et Praperties

F

© 2005 IBM Corporation

You can run programs from the Remote Systems view or the iSeries Table
view in four ways:

«In the RSE communications server job

«In a batch job

«In an interactive job

«In a server job

In the first case, running the program in the same job as the Remote System
Explorer communications server job,will tie up that job until your program
ends. With batch and interactive jobs, you cannot monitor the status as easily,
however, you do not tie up your communications server and you are notified

when the program ends. Batch jobs work as you would expect, your
application will be submitted to the default batch subsystem.

Note: A multi-threaded debug session creates a new server job and this way
keeps the RSE communications server job free for other tasks.
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dp Remote System Explorer - WebSphere Developm:

File Edit Wavigate Search Project Run ‘Window H

- 13[4 -G D% - ||
5 Remots 5y Run As 3

X [ o xR
N New Connection -
Local

=48 My Server

(- iseries Objects

-6 wiork with libraries. .
-2 wiork with objects. .

2} Tﬁ wiork with members. ..
i Library list

Wl osv¥s2924. Mib.prod-sys
I, Q5Y5.#lib.prod-sys

i, Qsvs2.Mlb.prod-sys
Wl QHLPSYS. #ib.prod-sys
i, QUSRSYS.Hib.prod-sys
Wl QGPL#ib.prad-usr

I, QTEMP M. best-usr
-, RSELABO4. M. prod-ust

| ] |

4P Remote System Explorer - WebSpher

velopment Studio Client Ad

Run Configurations: for easy re-use!

Create, manage, and run configurations

Configurations: Mame: | My iSeries program for run

- By Compled Applization
- iseries: Run Appiication i
- iseries: Run Batch Applic

How Ta Start |‘g§. Commen |

Connection: |My Server

Command to start application:

ol

CALL PGM{RSELABD4PAYROLLG)

i orkbench
4 Script Host Application

- server
- i websphere v5.1 Applica
528 websphere v5 Applicatic

Frompt...

Appl Revert

fn |

Existing run configurations are easily
accessible in run pulldown!

Close:

tion

Run configurations are for powerful re-use. If what you want to run a program
that takes a number of parameters, or is not straightforward to launch, you can
predefine this information into a named configuration. Once created, the
configuration appears in the configuration list, and can be selected from there.
Every configuration run also appears in the pulldown menu of the Run tool bar
button. Clicking the Run tool bar button itself, will run the previous

configuration again.
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User Actions and Compile Commands

Running Interactive Commands in RSE
- RSE Filters and Filter pools

Working Disconnected

iSeries Projects
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Drilling Down

» Typically we start using the RSE by just expanding:
— Expand Library list to see libraries on lib list
— Expand a library to see all objects in it
— Expand a source file to see members in it
— Expand Home directory to see folders in \home in IFS
— Expand a folder to see all folders and files in it
— And so on

= But sometimes this produces lists that are too big
— Its unwieldy to scroll through thousands of things

— You really want to keep lists small, to a few hundred at
most

' i '\
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The Remote System Explorer is all about random access to remote things ...
like stuff in QSYS, or jobs, or IFS files. While it is designed to be immediately
useful by merely expanding nodes to drill down to what we want, sometimes

that can produce unsatisfactory results if this results in vast numbers of items.
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*LIB Expand To = For Quick Filtering

#-_IN New Connection
+-B Local =S
Ay Linox B My ISeries
= ‘;;ISEFIES c =) § iseries Objects
- iseries Objects = ¥l 22 Work with libraries. ..
5 3 Workwith brsrss... 5 Refrash Data Files - 2 Workwith objects...
i 3 Work with obieets. . Expand EeiDevice Files 513 Work with members. ..
3
+ g xﬂhork w;t}l members, ., [ Message Files = W Library list
= ibrary sl +-ify, 5Y5 Hib.prod-sys
Ml Q5YS. b, prod-sys Change Current Library... 12 save Files + & SEVSZ.*‘Ih?pde_:ys
+-Mil, Qsvs2.Hib.prod-sys . Programs And Service Programs -l QHLPSYS. Hlib, prod-sys
) [ffy, QHLPSYS.*ib, prod-sys anams £ Modkes +-[ffy, QUSRSYS.Mb.prod-sys
4 Iy, QUSRSYS. *lib.prod-sys Copy =
- — B 703, Binding Directories
+ Wil QTEMP.*ib,test-usr [Data Queuss
= il POPALTP270.Mb produsr | 3 Delete a - QDDSSRC, *file.pf-src
| » Data Areas N
LB et oy stowin i B cooscr et
# i}\ POPALRR. "Ib prﬁg—usr Change(3)... v A i % e illrallpf-rsrc
+ il 9GL i prod-usr Save.., . Eh ggr:fégs'c.»laf;;c
il POPAIRS270,*lb. prod-usr Restore... -2 QRPGLESRCP, *file.pf-src
+ |l GUITEST.¥ib.prod-usr User Actions 4 + Wl QTEMP.*ib test-usr
+ ﬂ gsgtgsr“tb.przd-usr Create iSeries Project * & FOPALTPZ70.4b.prod-usr
=il b prod-usr +-Jify, POPALTDZ70,*lib, prod-usr
# '}\ APILIB. *ib. prod-usr Properties(F) £ ‘]\ POPAIRPZ70.*lib. prod-usr
=i User libraries = -Iff, POPALRR.¥lib. prod-usr
-l QGPL.*ib.prod-usr
+ |l POPAIRSZ70 ¥ib prod-usr

m u il
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One very quick way to reduce the amount of things is to use the Expand To
object for libraries. It allows you to expand a library to see only objects of a
particular type. This subsetting remains in effect forever, even when you re-

expand with the plus sign, until you subsequently choose All or any other
expand-to criteria.
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Introducing Filters

= Eventually you will need to see a subsetted list
— Using criteria like generic names, types and attributes
— All subsystems (nodes under a connection) support “filters”
— These allow fine-grained control over what is shown in the RSE.
» To create a filter, right click on any subsystem and
select New -> xxx
iSeries Objects -> New -> Library Filter, Object Filter, Member Filter

— iSeries Commands -> New -> Command Set

iSeries Jobs -> New -> Job Filter
— IFS Files -> New -> Filter
» Or use the fastpath Work With XXX... prompts under
iSeries Objects

3 » m' n—
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Eventually, you will find the need to see a subsetted list. That is what filters
offer, and the RSE has extensive filter support.
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Introducing Filters

+ = Work with lbraries...
+ :%G:> whark with objects...

=

o

¥ IFS Files
TORASIFE

Remiote Systems | Team

& Open Member...

B Openin Mew ‘Window

Run Command. ..

Properties

N Object Fiter...

X Member Fiter, .

s & ¢ *
% New Connection 0 g Lerary..

2B Locdl Go Into o

# A Linux oo | B Library List Fier ..

= % My i5eries

+ T Work with mambers. . i sho
+ i Library list
# jH User libraries Work With

El iseries Commands

9 Refresh
+ 2 vour command(s)... §9 Refred NeW
+-gp Add library ko library list
Pre 3 Change rurrent library Collapse f| Iter
- 3
. 1§ momrm el oo -
defined s 5 oo souco i - actions
) Verify Connection. .
f- Ite rs # 53? Create source member
| + Create duplicate objsct

El iseries Jobs Disconnect

+ §€> Active jobs
w My active jobs

* g My active j Start Remats Agent Controllsr
+ ﬁb My jobs Show Log(E)...
+ My jobs again

: m “. ir 1—
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Each of the subsystems contains pre-defined (shipped filters), e.g. Library List
(*LIBL) and a set of ‘New Filter Actions’, e.g. Work with libraries... Later once
are filter templates that require user configuration.
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RSE filters for iSeries Objects

= Library filters
— Specify simple, generic or special library names
» Object filters
— Specify simple / generic object names, lib-qualified
— Library name can be simple, generic or special
— Object name can be simple or generic
— Specify simple / generic object types and attributes
— Can specify one or more type:attribute pairs (OR operation)
* Member filters
— Specify simple / generic member names, lib / file-qualified
— Specify simple / generic member types
— Can specify one or more member types (OR operation)

L i '\
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There are three types of filters you can create in the iSeries Objects
subsystem.

1. Library filters. These list libraries when expanded.
2. Object filters. These list objects when expanded.
3. Member filters. These list members when expanded.

We will see an example of creating each of these. If you are an existing CODE
user, you can use File->Import to import filters from CODE Project Organizer.
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Library Filters

By 4~
B, Local & New |i|
-0 Uinox ) Library Filter 2
=Bl My iseries Create a new iseries ibrary filer 2
= §i iseries Objects =)
=% work with ibraries. . -

+] :%:D whork with objects.. |

1 = Work with memhers. .\ | Library: |*LAE*\ ﬂj Browse...

+] W Library list

| g User libraries
+- & iSeries Commands

+ &ISer\es Jobs Expand SpeCIfy Slmple’ SpeCIaI’
+ % s s or generic library name

=By TORASIFB

Library Filter i
Mext > i
—E Narne the new filter %D

>

Filters are saved for easy re-use. Specify a unique name for this filker, This name will
appear in the Remate Systems view, and will be expandable.

e rames [ inaned | SPECITY @ filter name

Remote System Explorer | Advanced
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Here we use the Work With Libraries... prompt to create a library
filter. Specify the library name, simple or generic, to list when this
filter is expanded. Note the generic names in RSE support two
asterisks, not just one as is the case with PDM. On the second page,
specify the name for this filter.
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Expanding Library Filters :

% Open in New Window
[ Show in Table

b &% Refresh
- New Connection USG Change
i e sk | to edit filter
T o s later
=1 3 Work with libraries. . ofn Rename:
| Filt: ted fully. E: d thi in b it th o
i %b \;;Drklwe‘tf‘hcf;j?gits‘sﬁccess Ully. Expan s 30ain to create anokher I's oy
] T Work with membes. . +F Move
0 ﬂ Library list N N % Delete
iy Uoer lorares Filter is created, and
= it [ es . i Move Up
Jili, ADTSLAB.*lib.prod
=ik ADTSLAEJL‘I*IiEI";md e)_(panijd' lt IISt_S a” i
¥ W AoTaLAG L it prad libraries matching Showin Taie
+-Jil, CODELAE. *ibprod X R .
% Jff, CODELABADM. *ib.prod the g|Ven criteria Properties
+-[fli, CODELABCW.*lb.prod .
w Ml AnE AR ik read ) ) )
Filter exists until
you delete it

Filter exists in all
connections by
default

v Al
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When a library filter is created, it shows up in the list of existing filters for
iSeries Objects. You can edit the filter by right clicking on it and selecting the
Change... action from its popup menu. When a library filter is expanded, all
libraries matching one or more of the filter's filter strings are listed underneath
the filter. Note that these libraries can subsequently be expanded, just as they
can for the Library List filter.
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Object Filters

X ed A |

| @3 iSeries Objects
i+ S Work with libraries ..
=

otk with obiects.

-2t Wk with mem
- Library list
i+ }ib User libraries
- My Libraries

# ék iSeries Commands

Create a new iSeries abject filker

- New Connection 3 Speley Slmple,
(] Local P . .
ot Object Fiter special, or generic

library name

Object type: | *FILE

Ubrary: ’W' SpeCIfy simple or
obpc H =l e | generic object name

jj Browse, ..
M

+ E; %ﬁ};ﬁ‘s o Obgect atrbute: [* o \ [~ Specify object type
ExpanE| More types\\ Specify simple or
(next page) generic object
e @ | | attribute

Mame the new Neer %D

Filkers are saved For eNgy re-use, Specify & unigue name For this filker, This name will
appear in the Remate SNtems view, and will be expandable.

Remote System Explorer | Advanced Filter name: | My Objects

Here you use the Work With Objects... prompt to create an object filter to list
objects in one or more libraries. Specify the library, the object, the type and

attribute filtering criteria. All but the object type can be generic.
On the 2™ page of the wizard, you specify the name for this filter.
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Filtering objects by type + attribute

4 Select Object Type

When More Select an object type: .
Types>>> pressed Prompt for object type
&k New -
Object Filter *,
il
Create a new iSeries object filter ﬁb Ct[; Select an objct attrbute:
: gmﬁl BSMBE ~
Ubrary: | ADTSLAG =1+ Bromse... E?ISD Eggaa
object: [ & =1+ Bromse... C[T)EALP caue :
Type and attributes to subset by: o Y E;gD EE‘ESE Prompt for object
*] 3 ject bype X
gt et | erowse.. I e attribute
S T multl |e biect attribute 4 DTAARA E;EE
pec_:lfy p Ad; | Erowse... DA &
EXITRG
object type * LA [
attribute pairs P—" i
PaS3a
PLI )
Will list all objects with e
e RPG
any of the specified == Y
—  types+attributes [ ] conn

A r A
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By using More Types>>>, you can specify more than one object type and
attribute combination. Note the attribute can be generic. This multiple-type
support is beyond what even PDM supports, and allows for extremely specific
lists based on filters.
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Expanding Object Filters :

105 Ren X ¢ 4t x ) Open in New Window
+-% Newe Cannection - 1 Show in Table
# Local
#- Linux 5 Refresh
i i ¥ Use Change
=I-&h iseries Objerts ol s
# :'=:€> ‘work with libraries. .. lapss tO edlt fllter
3
=5 work with objects..,
] Fiter crested successfuly. Expand this again to create another later
# :'=:€> ‘whork with members, .. ot Rename
+ ﬂ Libraty list o
+ i User lbraries Py
B My Libraries + Move
- # Delete
ALCRI *pom.rpgle 1 1
e Filter is created, and vt
LRMSG *pa. clp 1
e panch expanded. It lists all 3
ETTIVE. *pgm cle i i Shaw in Table
e objects matching
AVASETUP. *pgm.clp H HPC Properties
e oo the given criteria.

ABSETUP. *pgrm.clp
RTCUST, *pgm. rpgle
RTINY. *pgm. clp
RTINVR. *pam.tpale
TYLISRCLAS, *pgm.clp

Filter exists until
you delete it

Remate Systems | Team |

Filter exists in all
connections by default

F
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When an object filter is created, it shows up in the list of existing filters for
iSeries Objects. You can edit the filter by right clicking on it and selecting the
Change... action from its popup menu. When an object filter is expanded, all
objects matching one or more of the filter's filter strings are listed underneath
the filter. Note that these objects can subsequently be expanded, if they are
files, just as they can from the Library List filter.
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Member Filters

2B ¢ o4 v x i i
+ N Mew Connection ~ SpeCIfy Slmple'
o] 4] | special, or generic
=] % My iSeries Member Filter i i
= @nlﬁeﬂes Objects Create a new iSeries member fiker ',2> Ilbrary name
= 3 Work wih braiss.. > - -
4 2 Wwark with objects. ., SpeCIfy SImpIe or
[

[ Waork WIED Mempers .. - [RotaLin El g

T Lbrery bt Gy = eneric file name
+ iﬁb User libraties File: GRPGLESRC - j % g

+ iﬁ> My Libraries [

= 8 iy obieds enber: [+ e Specify simple or

) &k iseries Commands

4 ey kel < == || |generic member name
= By TORASIFE Mors Types>>
r ~

Expand [~ Specify simple or
generic member type

[ More types>> (next page) |

NaWthe new Filter %D
=

Filters are saNd for sasy re-use. Specify a unique name for this Fiter. This name wil
appear in the Aot Systems view, and wil be expandable.

Filter name: | My Members|
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Here you use the Work With Members... prompt to create an object filter to list
objects in one or more libraries. Specify the library, the object, the type and
attribute filtering criteria. All but the object type can be generic.

On the 2™ page of the wizard, you specify the name for this filter.
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Filtering by member type

When More
4P N
= Types>>> pressed 4 Select Member Type 53]
Member Filter *" —
Create a new iSeries member Filter |:“ = Select a member type:
*" FELAMK ~
BMND 3

Library: | ADTSLAE ﬂJ Browse... EBL
R 21 e || |10

CLE

=+ Browse... ClE

cLp
~ I D
e

Member types to subset by CPPLE
PG Mernber type o
_ e =l eromse.. W& I
- - add
Specify multiple member > [y
. MMUCHE
types. Handy when generic Remove mcos
name won't work iLGRe L
| | Mext > | Finish Cancel |: e

Will list all member with
any of the specified types

i &
A r Al
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By using More Types>>>, you can specify more than one member type. Note
that each type can be generic. This multiple-type support is beyond what even
PDM supports, and allows for extremely specific lists based on filters.
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Expanding Member Filters :

Ry " v %

= @3 iSeries Objects
) S Work with libraries. .

% Open in New Window
[ Show in Table

&% Refresh

Use Change
Collapse to edlt fllter
later

] 2 Wtk with objects. . o Rename
- 37 Wark with members, . Copy
] g Library list
= %{i User libraries f :;:e
= g My Libraries . .
% g My Objects Filter is created, and o
Sl 31y Members .
T PAYROLL.rpgle eXpandEd. It lists all &
[y PAYROLLG.rpgle . -
+ E%\Series Commands memberS matChlng Show in Table
* iseries Jobs . . .
% IFsFies the given criteria. Propertes
4 By ToRASIFE

Filter exists until
you delete it

Remote Systems Team

Filter exists in all
connections by default

v Al
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When a member filter is created, it shows up in the list of existing filters for
iSeries Objects. You can edit the filter by right clicking on it and selecting the
Change... action from its popup menu. When a member filter is expanded, all
members matching one or more of the filter's filter strings are listed
underneath the filter.
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Filter Pools

= Eventually you will have too many filters!
— Or you will want a filter not to show in all connections
= Time to turn on “Show Filter Pools”
— Expanding subsystems will then first show filter pools
» Filters are grouped into named pools
— By default they are added to the “default filter pool”
You can create your own filter pools
Then add filters to it
Expand a filter pool to see just the filters in it
Connections reference filter pools ... only see those you reference

— The default pool is always referenced
» Filter pools group filters
— Nothing more than a named collection of filters

— Allow you to group filters by project, release, connection, task, etc.
" ] i Al
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There is an advanced feature in the RSE for partitioning filters into named
collections, called filter pools. To enable this, you must select the "Show Filter
Pools" preference. It is available from the Remote Systems toolbar down
arrow menu.

Actually, all filters are contained in a filter pool. By default, they all go into one
IBM supplied filter pool, named Default Filter Pool. By turning on the Show
Filter Pools preference, you will see these filter pools when you expand a
subsystem. When you expand a filter pool, you will then see the filters. Filter
pools can be used to effectively group filters by task, or project, or release, or
developer, or whatever you like.
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) Available from the
Show Filter Pools Remote Systems

toolbar menu

+
- X | + %8, Local
# Q Lirnx
R ogh | o oaE Mew Connection, .. =38 My iseries
- - = fiy i5eries Objects
=E\= Mew Connection Wark With Profiles = e
- Local W o= workuith lbraries...
E‘& My iSeries Refresh all & ;ﬁb Work with objects...
& iSeries Objects . ) = g Work with members. .
; ualify Connection Names !
% wiork with libraries. .. Gty o i Lbrary fst

Show Filker Pools 51 e User libraries
' work with objects... shoslkeioo] 4

v
5 Work with members v Restore Previous State = g my '(-)':ra”tes
e g My Objarts

iy Library list PlicfEiEnE=s * 1 T My Members

iﬁb User libraries
iﬁb My Libraries

%k iSeries Commands

Stop Communications Daemon ‘ +-Tfi® Mypc Filter Pool

+ EI% My Objects \ %I}S:i”;?;:b:nter Poal
a% My Memnbers *h IF5 Files
&% iSeries Commands & e Mypc Fiker Pool
[]--@ i R Remote Systems | Team
HE" . Connections -
Connections | Subsystems Show Filter Pools
- Subsystems . Filter Pools changes the view to
- Filters | ; show filter pools first,
Remoke Systd = F| Ite I‘S .
— then filters

Al
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Here we see how to turn on the Show Filter Pools preference. Once enabled,
when a subsystem is expanded you see not the filters, but first the filter pools
referenced by this subsystem in this connection. When a filter pool is
expanded, then you see the filters within that filter pool.
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- Hew Connection
= B Lacal
+ Q Linuz
=18 My iseries
=

=I-_§® Mypc Filker Pool

#- % New Connection
+ '8 Local

+-0) Linux

=8y My iseries

= g?n iSeties Objects

+-Be Mypc Fileer Pool
I & iseries Jobs

# }:i Mypc Filker Pool
=¥ IFS Files

- THe Mypc Fiter Pool

Create a Filter Pool

& New Filter Pool )

System Filter Pool

Define a new pool for filkers *&0

B gd A g

Go Inta
GoTo

/ Open Member, .,

4 Paol name | My Focl|

Profle  |MyPC =l

i Library. .

Filter Pocl Reference »

Now you can create a new
filter pool for a connection...

& ¢ S

[t X Library List Filter,.,

Ga Inta
Go To

o Window

&5 Refresh

o Rename

N N Library Pl

+¥ Object Fileer. ..

X Member Fiter. .

...and then create filters
in that filter pool

: m “. ir 1—
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To create a new filter pool, right click on the subsystem, then select New ->

Filter Pool...

All you need to specify for your new filter pool is a unique name. This is what
you see when the subsystem is expanded. Never mind the Profile prompt for
now, we will explain that later. It is defaulted so you need not think about it.
When Finish is pressed, the filter pool is created, AND a reference to it is
added to this subsystem in this connection. No other connection has a
reference to this new filter pool yet!
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Reference a Filter Pool

ST YT By default, only the connection where
T3 e you created the filter pool has a
+ acal . . ..
2B e reference to it, so filters created in it
= % My iSeries .

L mes cbjects only appear for that connection

- Be Mypc Filter Pool

&8s iseries Jobs

4 ¥ IFS Files T
=-Fh TORASIFE yatems & 4 v %
I gy iSeries Cbjects =N Mew Connection
+ Te Mypc Filker Pocl + B, Local et g Library. .
gk iSeries Commands w03 Linux Go Into s
+- g8y iSeries Jobs = {8 wy iSeries GoTo  §& AherPaal.
% s IF5Fibs = 5 Serios Chisets Filter Pool Reference b
+ o Hype Fiker Fool # Open Member ..
Remote Systems | Team : Ek:\?;nl::gs:mands 8 open in Mz window
+ a iSeries Jobs E Show in Table
+- %2 IFS Files work .
-8 e ** " To share a filter pool between
= @’3‘ Refresh H
@;{E- Hiype Filer Pool connections, create a reference to
gk iSeries Commands
I :
* ofly Series Jots ol the filter pool from other
- Ty IFS Files °f Select A .
connections

Remote Systems  Team

v i
50 Remote System Explorer | Advanced © 2005 IBM Corporation

By default, filter pools you create are not shared by multiple connections. To
affect that, create a reference to the same pool from multiple connections.
Note any changes made to the filters in the pool are now immediate across all
shared connections.
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In Show Filter Pools mode, there are
Work With Filter Pools two new actions on subsystems
like iSeries Objects:

5 ) 1. Work With Filter Pools
2 3 New Cornecton o R 2. Select Filter Pools
A Linux GoInto
= % My iSeries GoTo 3

= ﬁj iSeries Cbjects
+ 30 Mype Filter Pool / Open Member ..,
TJie ty pool B3 Open in New Window
+- &R iSeries Commands _ .
By iSeries Jobs Show in Table

+ ¥ IF5 Flles

% Work With Filter Pools K

Wark with filter pools
G L

- % TORASIFE = T:eam Move selected filker pool ko & different profile
= & Refresh TBe My Fiters
E}t S" MVDCC Filter ';Wl =, Named Typss... _ Jge Team Fiter Pool
+ iSeries Commands = B MyPC
-l iSeries Jobs Sollapse 5, compile Commands. .. | 3\1

ypc Filker Pool

4 Ty IFSFiles

68

1. WW Filter Pools:
Select filker pools ta include in this connection one Stop Shopplng for fllter

SO pool management
EDE- TEYam Filter Pool

- Ok .
B e rper s 2. Select Filter Pools:

- Easily manage which pools this
———— connection references H
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When you are in Show Filter Pools mode, you will see a couple actions on
subsystems, for managing filter pools and managing references to filter pools.

4P Select Filter Pools
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Table of contents

Customizing Workbench and Editor
User Actions and Compile Commands
Running Interactive Commands in RSE
RSE Filters and Filter pools

¥ Working Disconnected

iSeries Projects
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Working disconnected What you can do while disconnected j

—

L
v Edit local and offline source files / mbrs
v Syntax check RPG, COBOL, DDS
v Syntax check CL for cached commands
v Prompt RPG and DDS
v Prompt CL for cached commands
v Access language help for RPG, COBOL, DDS
v Access CL help for cached commands
v" Verify RPG, COBOL, DDS for those members that are cached

—

¥' Edit, design or comﬁle host source members
¥ Run or debug host programs
¥ Run host commands
v Syntax check, prompt or F1 on CL commands not cached
¥" Verify members not previously verified

vl
53

Remote System Explorer | Advanced

| What you cannot do while disconnectedj

© 2005 IBM Corporation

This summarizes what can and cannot be done when working in disconnected

mode ... that is, without a live connection to an iSeries host.
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Caching

= Verify source member
= Caches information [ =)

» To update cache: = oot
Defines -
Select Verify (Prompt) F

CL [Select to ensure that all cached items are refreshed. |
Cache

Select Refresh cache
Click OK

Source Compile Mavigate Search  Praject
Hew s

Prompk F4

Synkax Check all

¥ verif

ChrHShift+y

Convert Al To Free-Form

Select Format Line. ..

Show Indentation

Shiow fields

JCOPY Member 3

ILE RPG Help r
Restore Defaults Apply

Resequence Al Lines

Refresh CHHFS
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When you verify a member, the external references are automatically cached
locally. On subsequent verifies, the local cache is used. To force a refresh of
the cache, prompt the verify action and select Refresh Cache.
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Cache Settings

JSI=IE

[ Crystal Reports Viewsrs | Cache |
[# Data
- Help I Disable caching
[ Install{Update
B Internet I™ Maximum cache size (mB) |50
[ iSeties Projects
T2EE Current cache size (MB) & wl
[ Java
[+ LPEX Editor Cache location I D:lappstibmiwSAD_Workspace|iRADS_0iFall2005_COMMOM, metadatal.  Browse...
[ Modeling
- Process @l
=) Remote Systems ¥ Cache CL help and prompts using host name as the key (most accurate).
Corkstions " Cache CL help and prompts using host release as the key (quick).
s € Cache CL help and prompts ignoring hest name and release {quickest).
Files
(=] iseries Clear the current cache Clear
Cache
Command Executio
Command Subsyste
Job Subsystems
LPEX Editor Parsers
Obijects
Program Verifiers
Table View
Templates =
4 | L'_I Restore Defaulks Apply

Tl | el |

il
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You can affect cache settings via the Cache preferences page.
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Make Available Offline

Fle Edt Mavigate Search Project Run Window Help

I Remate Systams XeP e m|Hsf v x B-EES |GG |53k
: % [J:CV;ICD”"EC“” P v =gl - - - roject Navigator - x
=5 Linux Open With @ E > = _E‘§’ L
= B My iseries Ao With In order to Work @ || 5 My iBeries_CCDELAB
BN [Series Cbjects ) i =B orPaLESRC
it dvrhermenih L offline, you have | | *| & o
# %rﬂhorkw;timamharsm ;WV to make a local T PP as07m_ORDLIE
- W Library s e
= i ot 2 Delte copy of your This creates an iSeries
“ o Verfy member first. project, and imports the
My Members Werify (Prompt) . ’ . ..
Dy | e Use Make Available member(s) to it. This is
! HHOUE Ealfo Compile (Prompt. . .
: % et o Lot fetone Offline where you work offline
+ "ED IFS Files Add To iSeries Project... iSeries Project Mavigator |Mavigator |Bookmarks |

[+ ‘ TORASIFE Make Available OFfline

Compare With

Propertios

What are iSeries
Projects?
Stay tuned...

b iSeries Projects Question

@ Source member PAYROLLG will be downloaded localy/fnd added to iSeries

Remote Systems Team

o
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To prepare for working offline, use the Make Available Offline action on the
members you intend to edit. Then, while offline, you edit your source from the
iSeries Projects perspective. More on iSeries Projects later.
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Customizing Workbench and Editor
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User Actions and Compile Commands
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Working Disconnected
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iSeries Projects

e T x|
[ ] i i ornponent Tes! -
A SpeCIaI proJeCt type . @Evsiepos:tlrytExploring
—For holding source destined ;"@EZ@L
to be compiled on iSeries e
MGl web
. . i’?glnstall,fl.lpdata
= A dedicated perspective A
—For working with all and only S i
|Ser|eS prOj eCtS EjJava Type Higrarchy ;I
=T Ol mein Miaalnnmank
Cancel |

N ﬁ' 1—
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There is a special project type designed to hold source that is destined to be
compiled and run on an iSeries. There is a wizard for creating a new iSeries

Project.
There is a special perspective for working with iSeries projects.
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What is an iSeries project?

= Typical Eclipse project
— Contains folders and files, can be shared by a team

— Can have its own tools and perspectives
= But also
— Holds copies of some source members from an iSeries library

— Those copies are “pushed” up occasionally and the project
re-built

. N\ 7id . ir 1—
59 Remote System Explorer | Advanced © 2005 IBM Corporation

An iSeries Project is a typical Eclipse project. This means it contains folders
and files that are in the local file system of the IDE, but these can be
synchronized with a central repository for team support.

Since the files are local, there is actions to support "pushing” those files up to
an iSeries library, where they become source members. This is done prior to
compiling or "building" the source for the purpose of testing.
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iSeries Project Library, files, members

= iSeries Project

— Each iSeries project is associated with a single iSeries library
— 11to 1 association

— Use File -> New -> iSeries Project wizard to create
» iSeries Source Physical File

— Source physical files represented as folders in the project

— CCSID, record length, IGC data and description stored as “metadata”
for folder

— Use New -> iSeries Source Physical File wizard to create
» iSeries Member

— Members stored as files within “source” folders

— Uses format: memberName.membertype ORDRENT. RPGLE
— Use New -> iSeries Source Member wizard to crate

" m' 1—
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iSeries Projects Perspect
4F iSeries Projects - PAYROLLC.CBLLE - WebSphere Development Studio Client Advanced Edition for iSeries
File Edit Source Compille Mavigate Search Project Run Window Help
ST T ok ||® 7] - ;7
B || 2g series Froject Navigator v X || ARATROLLC.CBLE X B2 outline x
] :r_,: & Row 3 Column 1 Replace IDENTIFICATION A
@ 2 =2 | —— i 2 3 4 S———| = ENVIRONMENTC
@ |E 1= My iSeries_CODELAB
= % QeBLLESRC 000003 IDENTIFICATICON DIVISION. ~ + CONFIGLRA
& % PAYROLLC CELLE 000004 o DAT?E';\L;ELP
E-E B PAYROLLC2, CELLE 0nooos PROGRAM-ID. PAYROLL. =] L SECHC;
+
'E PAYROLLD CBLLE ao0o06 AUTHOR. Programmer Name. )
- B qopsskc 000007 INSTALLATICN. IEM Toronto Lab. + WORKING-5
® EMPMST.PE 000008 DATE-WRITTEN. Octoher 12, 1999, - PROCEDURE DI¥
[ MSTDSP.DSPE 0000039 DATE-COMPILED. ETEE—;’I;;:J:-Ef
0% MSTDSP2 DSPF I papegiing
2 MSTDSPY.DSPF uLiTolofLil i il
- E% oRpeLESRC 000012 * PROGRAM DESCRIPTION 0200-CHECK
1% PAYROLLRPELE 000013 * — Time reporting waster file waintenance us 0200-EXIT.
% PAYROLLE RPGLE 000014 * described workstation processing. = EiEE'EEiMS
T T7_WFLABKX ¢ | Il DESD-EMPI‘:!IS
+ 1z taras07m_ORDLIB = = -
O350-ERIT, »
iSeries Proje.,, | Mavigator |Bookmarks | <5 >
v X || fig iSeries Build Job Status g x
ol 49’ DatejTime Submitted | Job ‘ Project Status |
5 & Linux A | | 92P 18, 2003 11:57:42 AM 011903/COULTHARLBEH. ..  toras07m_ORDLIB Finished
Z % My [Serias — | | 5ep 18, 2003 &:37:04 PM 012056/COULTHARLEEH. .. torasO7m_ORDLIE Finished
= & iSeries Objects
= :ﬁ? }vyur!&wwltr'l I\II:rarifas.‘ ]
< | 2 4] ¥ |Refresh Interval: Mever
Remate Systems Properties Tasks |iSeties Commands Log |iSeries Build Job Status |iSeries Error List | iSeries Source Prompter
Select prafies o roake ot
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Here we see the iSeries Projects perspective, which you can explicitly
open. The primary view is the iSeries Project Navigator that allows
exploration of all existing iSeries Projects. There are wizards
lauchable from the toolbar for creating a new iSeries Project, or
creating source physical files and source members within an existing
project. The iSeries Projects perspective includes a full copy of the
Remote Systems Explorer, as a view, for your convenience. This
allows you to easily work with the contents of the associated library
while simultaneously working with the local copies of the source
within the project.
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iSeries Project wizard

iseries Project

iseries Project Properties

Specify the iSeries project properti Connectlon
from RSE list

Give your
project a
name

Create a new iSeries project that maps ta an iSeries lig

Project name: | My iSeries Project

Connection: My iSeries

Project contents Associated library: | APILIE

V¥ Use default

|

SBrowse, ..

Specify the connection and library name to associate with this iSeries praject. The
connection allows For remate access to the iSeries host machine. Code changes
made locally are pushed to the specified remate library, That library is also used Far
Specify the name and location of the iSeries project being created, An iSeries el s o e et ek

project allows For local development, while performing builds on a remate iSeries " " . —
hos . Identify Associated Library: this is the
target library for pushes and builds

I et = I ‘ Cancel ‘ < Back | Mext = I| Finish I Cancel ‘ |
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Here we see the iSeries Project wizard. First, give the project a
name. Any name you want! Then select or create a connection (from
the RSE!) that identifies the iSeries with which this project is
associated. Also select the library on that iSeries where the contents
of this project will be pushed to.
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Build style controls how the iSeries

iSeries Project Wizard (next page)

4 CL Program Build Style Configuration 3

project is built on the remote system

iseries Project Properties

Select and configure the active build style For this project. ﬁ—

ictive build style:

Configure, .“|

Enter the praject's source File that contains the COMPILE.CLLE and BIND.CLLE members that will be
uploaded to build this praject.

Build Source File:

[ wcLsre

IV Automaticaly generate COMPILE, CLLE prior to each build
[v Butomatically posh all chanaed members prior to build

Cornmand
FHONE

This build style will upload CL programs specified in the configuration, compile them,
and then run them to build this project. The compile commands can be automatically
generated,

Pravided by IBM plugin “iSeries Prajects - Remate Build Styles Plugin” wersion 5.1.0

| Finish I

Cancel ‘

Remote System Explorer | Advanced

Specify Build Style and
style configuration parameters
for iSeries Project
more information on next slide ...

4 Command Build Style Configuration

Enter the command to be submitted to build this project.

Build Command:
I

I Automatically push all changed members prior to build

© 2005 IBM Corporation

Cancel

Here we see the rest of the iSeries Project wizard. Here you specify
what to do for the Build action on a project. There are 3 IBM-supplied
choices, and ISVs can add more choices. The default is to generate a
CL source member containing a compile command for each member

that is changed.
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Build Styles

» Specify how to build the iSeries project on the
remote system

» Three IBM supplied build styles
CL program
Command
*NONE

= ISVs can plug-in additional build styles

. 4 A
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CL program
« Automatically generates COMPILE.CLLE and BIND. CLLE
« Adds compile command for each source file in project
« Uses last compile command from RSE for specified source type
« For example, CRTBNDRPG versus CRTRPGMOD

« At build time these two members are pushed to iSeries, compiled
and run

Command
* You specify single command to run build
« Good if you have an existing build script

ISVs can plug-in additional build styles to work with their existing iSeries
systems
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iSeries Source Physical File Wizard

4P New E| & New El
iSeries Source Physical File iSeries Source Physical File Parameters
Create a new local source physical file under an iSeries project. %j Specify additional parameters. %
Enter or select an iSeries Project: Caoded character set ID: ‘ *JOB j
[y 15eries_CODELAB Record length: ‘ 11z j
o 1GC data: r
+-1a% AutoworldExample ~ i ‘
+ 125 fukoWorldExampleEAR,
+ 28 AWeb P Select
+-159 A Web Project . These attributes are used when the *FILE is created in the associated library of the
+ 128 CompanyWehSiteExample P roject i5eries project,
+-op DefaultEAR,

+- 125 DefaultEARTest

% Tab My iSeries_CODELAB SpeCIfy attributes that are
B — used when file is finally
vt created in associated library

+ 1 RemoteSystemsConnections
+-{zF RemoteSystemsTempFiles
p=—

Source File = a folder in your project

Fie name: [mpaesee | »Until you "Push” your changes.
advanced > »Then a CRTSRCPF is done

Select an iSeries project and enter the name of the new source physical file being

created, The source physical file will map to a Folder under the selected iSeries

projeck.
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Here we see the wizard for creating a new iSeries source physical
file. Within the project, this is actually a folder. When the project is
pushed to its associated library, this result in a CRTSRCPF command
being run to create a file with the attributes specified in this wizard.
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Select the
parent folder
(srcfile)

Remote System Explorer | Advanced

iSeries Member wizard

iSeries Member

Create a new local source member under an iSeries project.

Enter or select a source physical file under an iSeries project:

[ My i5eries_CODELABGRPGLESRC

Member = a file in your

5

+-{z AukoWorldExample
+ 159 AutoWworldExampleEAR
+-15% A'Web P
+-15 A Web Project
+ 15 ComparyWebSiteExample
+- 123 DefaUltEAR
+ 125 DefaultEARTest
=1 My iSeries_CODELAB

+ 3 QUELLESRC

+ [ QDDSSRC

+ (3 QRPGLESRC

folder
» Until you "Push" your
changes.
»Then an ADDPFM is
done, or
»Contents of remote
member are replaced

+ 128 My Old Weh Project
+-Ta My Project
+ -T2 My Web Project

Member name: | MYMER
Source bype:

Enter the
member name
and select
source type

Select an iSeries source physical file, and enter the name of the new source member
being created. The member wil map ta a file in the Folder representing the selected

iSeries source physical file,

RV
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Here we see the wizard for creating a new iSeries source member
within an iSeries project. Actually, it is within a source phyical file (aka
folder) within an iSeries project. Locally, a member is really a file on
disk. The file's extension is the member's type, as in ABC.RPGLE.
When this project is pushed to its associated library, this will result in
an ADDPFM command being run to create the file with the name and
type, in its parent file.
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What about existing members?

= Use Import or Add to Project action to copy them
» Files added become folders locally

» Members added are copied to that folder

= Developer works on local copy

» Full power of Eclipse at disposal

. 4 A
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Add project action
*Right click on project, select “Show Remote Objects”
+Drill down to source file, right-click, select “Add to Project”
+Drill down to members, right-click, select “Add to Project”

Developer works on local copy
+Edits file
«Pushes changes using “Push” action
*Does a build using “Build” action
«Shares with team using “Synchronize” action

67
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Project “Show Remote Objects” mode

4 iSeries Projects - WebSphere Development Studio Client Advanced Edition for iSerjes

File Edit Mavigate Search Project Run Window Help
B0 o Bk % ® e
igata - X EE Outline b3
@ l | = 5 An outline is not
= E% QCRLLESRC available,
ks % PAYROLLC.CELLE o Info
E.E IE PAYROLLCZ.CELLE Open in Mew Window
09 PAYRGLLD.CBLLE Inport Remote Objects...
- B opossec
% EMPMST PR
(% MSTDSP.DSPR 2y Copy
% MSTDSPZ.DSPF
(% MSTDSPY.DSPF @ .
= 5 aRpetesne % Delete Currently showing
[5 PAYROLL.RPGLE Maove. ..
% PAYROLLG.RPGLE Rename Only local
T T7_WFLABRN
) [ torasD7m_ORDLIE ExgImport. . resources
ey Export...
iSeries Project Mavigator | Mawigato
—— Clase Project
,!@ Remate Systems Refresh
B gb = 4 Remote Actions S & x
YT britted [ 30b | Project [ status
I & My iSeries Team ) Y 115742 AW 01190 COULTHARJLBEH. .. toras07m_ORDLIB F!n!shed
m n Compare With » | &304 PM 012058/COULTHARJLEEH. .. taras07m_ORDLIB Finished
= @3 iSeries Objects
1= wiark with libraries.
% 2 work with objects. Restore From Local Histary...
# ‘% Wark with membery Properties >
+ §>L\hrar Jist : :E" P
68 Remate Systems | Properties | Tasks |iSeries Commands Log |iSeries Build Toh Status |iSeries Error List |iSeries Source Prompter

Ihlion

Here we see an iSeries project in the iSeries Navigator, within the
iSeries Projects perspective, that has a number of local files and
members. Right-clicking on the project or anything in the project,
gives a popup menu with the all-important "Show Remote Obijects"

menu item....
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Project “Show Remote Objects” mode Now showing
both local and
i = P W F v x resources
|- Tz My iSeries_CODELAB

~
+- 5 QCELLESRC (Local{Remote)
=5 QDDSSRC (LocaljRemote)
0% EMPMST.FF (Local{Remate)
0% MSTDSP.DSFF (Local{Remate)
0¥ MSTDSP2.DSPF (LocalfRemake)
0% MSTDSPY.DSPF (LocalfRemate;

To add a remote member to the
project, select Add To Project

To do actions against remote objects, use
Show In Remote Systems View
1

I REFMST.pF (Remate)
I RSMMST.pf (Remate)
- Ef§ qrPGLESRC (Local/Remat
0% PAYROLL.RPGLE (Locs
0% PAYROLLG.RPGLE (Lad
=5 COMPARE. *File.pf-src (Remote)
I SAMPLELtxt (Remate)

Show In Remot

Refresh

(Remote) =>
»only exists in associated library

0 SAMPLEZ.bxt (Remate) [Local/Remote] => Lo

EMPMST *file.pf-dta (Remate)
EVFEYENT . *File.pf-dta (Remate)
6@ MSTDSP, *File.dspf (Remate)
PRIMST. *file.pf-dta (Remate)
¥ E} QILSRC *file.pf-src (Remate)
+-Ef QCMDSRC *file.pf-sr (Remate)

»exists locally and in associated lib
(Local/Remote] =>

»conflict between local and remote
otherwise =>

»only exists locally

+-[Ef QRPGSRC.*File.pf-src (Remote)
=71 I

1
[— | iSeries Project Mavigator | Mavigator |Bookmarks |
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Once "Show Remote Objects" is enabled (it is a toggle) all the objects
in the associated library for this project are shown in the iSeries
Project Navigator. This navigator is called a "bleed through" view
because it lists both local files/members and remote objects, files and
members. However, if a file or member exists both locally and
remotely, it is not shown twice. Rather, it is only shown once, and its
icon and bracketed text identify it as existing in both places. The icons
and text enable you to see at a glance which files/members exist only
locally, only remotely, or both locally and remotely. In the latter case,
the color of the icon indicates if the two are in synch or not. If not, it is
an indication you need to "push" your local source to the associated
library to get it in synch.
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Project Build

Progress Information

o B =

01 B Pushing Changed Resources.
Hew 3
%= QCBLLESRC (Local

5o Into
= Ef %Dgsﬁsﬁsﬁﬂf cpen in New Window LT T

(% MSTDSP.DSFR Import Remote Objects. .. B e RE TR )
[ MSTDSPZ.DSFE W Show Remate Objects
% MSTDSPY.DSPR

O PRIMST pF (R [ Copy

% REFMST.pF (Re B

0 RSMMST.pf (R
= [Eff QRPGLESRC (Locs ¥ Delete —
E PROLLAFG)  Move. After editing, you
¥ PAYROLLGRPY Rename 1
= B coMpare. *File.pf| n h n
[ SaMPLELExt Exslmport... | ca _pus al d
B O saMPLEZ.bt { p AExport. ., bu||d your
EMPMST *Files. pf-clt
EWFEVENT. *file. pf- Closs Praject chanoes
&3 MSTDSP, *file.dspf Refresh q
PRIMST. *file, pF-dit 5
- (2§ QELERC, #Flle. pf-sr [55) work with Compile Commands. ..
+-Ef QUMDSRC *file.pf Team N
RPGSRC, *file. pf-
M Compare tith | Generate COMPILE CLLE
iSeries Project Navigator | Nav
— Restore from Local History,..|  Push Changes
U Remote Systems Push Selected
f—— Properties

0 PAYROLLGrpgrs

EXa.
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After editing, you will want to send the changed members back to the
associated library, and then compile them there. This can be done in one step
with Submit Build, or in two steps with Push Selected and then Generate
COMPILE.CLLE.
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iSeries Build Job Status

Job where build Status of the
is running ¢ 1 build
& x

Date)Time Submitted Job Praject ‘ Status |

Sep 18, 2003 11:57:42 AM 011903/ COULTHAR/LEEH. .. toras07m_ORDLIB Finished

Sep 18, 2003 5:37:04 PM 012056/COULTHAR/LEEH. .. toras07m_ORDLIB Finished

Mov 2, 2003 6:33:49 PM 035448/ COULTHARJLBEH. .. My iSeries_CODELAB Queued

ﬂ J ﬂRefresh Interval: 30 seconds

iSeries Commands Log |iSeries Build Job Status || iSeries Error List
Refresh interval
determines how frequently Retrieve errors from
status is updated build to the
iSeries Error List
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7 Remote System Explorer | Advanced

This shows the Build Job Status view where you can monitor your
submitted build jobs.
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Fle Edt Soorce Compile Navigate Search Project Run Window Help

S e || T -%-K- @] Ce-D s
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@
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+ 5 crealEsRC 000500 CHGFF SRCFILE (CODELAB/QDDSSRC) SRCHMER (EMPHMST) OFTICH(
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000900 ENDDO

001000

001100 CRTDSPF SRCFILE (CODELAB/QDDSESRC) SRCMER (MSTDSP) REPLA
001200 FILE (CODELAB/MSTDSP)

001300 MONMSG MSGID (CPFOOO0) EXEC (DO

001400 CHGWAR VAR (&FRILED) WVALUE (£FLILED + 1)

<

iSeries Project Mavigator |Mavigator |Bookmarks

fuff] iseries Build Job Status

J!,. Remote Systems - X
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Sep 15, 2003 11:57:42 AM 011903/COULTHARILEEH. .. toras07m_ORDLIE Finishe
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Remote Systems  Propetties
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An example of what is generated for the build. This is a CL member. You can
affect what compile command is used for each member type.
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Prod Lib

Using Projects

Test Lib

library list libraryjist library list

/ |
Dev1 Lib Dev2 Lib Dev3 Lib

A
Team push push push
build build build

Repository
Dev1 IDE Dev2 IDE Dev3 IDE

< * team * team * team

sync sync sync
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The typical usage scenario for iSeries projects is to use them for
tasks, such as adding a feature to an existing application. Rarely will
you use an iSeries project to hold all the source for an application...
use an iSeries change management vendor for that. Consider a
change that involves 3 developers changing a number of files...

The lead developer will create the iSeries project and synchronize it
with the repository. The other developers will use the Eclipse team
support to add that project to their workspace. Each will change the
properties of the project to associate it with their own private library.
The master library containing all the source will be on their library list,
so compiles will work, but their private library will only hold the
members they work on. If they use an SCM product, then they will
use it to check source members out to their private library. These
members and files will then be imported into their project, where they
will edit them.

After editing, they will "push” their changes to their library and do a
"Build" or a compile, and run and test their unique changes.

Every so often, they will do a team synchronization to give their
changes to their fellow team members, and pick up the changes of
those team members. After a synch, they will push their colleaque's
files to their own associated library and test the changes all work
together.

At the end of the cycle, someone will pick one of the libraries, and use
the SCM product to promote their changes back into the test and
production stages.
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Profiles

» The RSE is designed for team sharing
— Of connections
— Of filter pools
— Of user-defined actions
— Of compile commands
» Team sharing is enabled by profiles
— All connections, filter pools, user actions are scoped per profile
— Each profile is a folder within the RSE project
— All data stored within subfolders
— When RSE project is team-synched

— All out-going changes sent to team repository
— All in-coming changes received from team repository
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team
environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,
such as mainenance of an application. The RSE leverages the
Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see
the information of. Team sharing is done using the Eclipse team
support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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RSE Enhancements in version 6.0

QCL Changes

Indicator for used parameters
Selective prompting:
Support of all prompt modifiers (ie ?*)
Support labels and comments (when editing CL source).

Additional error checking for built-in commands (ie
%SST)

A refresh cache button
Context of non-edit and edit mode will be permitted
UError List enhancements
UNo power user/admin authority on windows to
access PV and SC
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team
environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,
such as mainenance of an application. The RSE leverages the
Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see
the information of. Team sharing is done using the Eclipse team
support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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Indicator for specified parameters

ooo700 CRT3RCPF FILE (CACHECOFT1/QRPGLESRC) RCDLEN(112) J
ooos0o0 CPYSRCF FROMFILE (ECLIPSTEST/QRPGLESRC) +
ooos0o0 TOFILE (CACHECOPY1/QRPGLESRC) +
oo1io000 FROMMER (CACHECOPYZM TOMEER (CACHECQPYZ)
oo1100 N TT TR T TR R SHE AT =1
':@_.‘é'l:upy Source File {CPYSRCF) x|
I Label:
] RPGLESRC
Pt Siyeian Batal Data base source file: >‘Q Mame
—_— Library: = EFECLIPSTEST - Mame
torasdaf I —
To file: > EORPGLESRC | Marng
m Library: = ACHECOPY1 I~ Mame
Library ECLIPSTES' From member: = JCACHECOPYZ ~ Mamme, generic*
Cause . . L.t —
ECLIPSTEST was a 10 member or label: > WCACHECOPYZ | Mame
Replace or add records: *REPLACE =
Source update options: - add |
=
Cormrnent:
[-|
Cornrnand INormaI
_ ™ Advanced ™ all Parameters [~ Keywords I
g Py A CPYSRCF FROMFILE(ECLIPSTEST/QRPGLESRC) TOFILE{CACHECOPY 1 /QRPGLESRC) FROMMBR{CACHECOPYZ) ;I i

== TOMBRICACHECOPYZ)

= 2005 LUG Meeting =
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team
environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,
such as mainenance of an application. The RSE leverages the
Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see
the information of. Team sharing is done using the Eclipse team
support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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Selective prompting

Selective Prompting Character

Description

The parameter is displayed and input-capable

The parameter is displayed but is not input-capable.
Anv user-specified value is passed to the command
processing program

< The parameter 15 displayed and is input-capable, but
the command default 15 sent to the CPT unless the
value displayved on the parameter is changed.

{4 Reserved for TBM use.

- The parameter s not displaved. The specified value
{or default) is passed to the CI'T Not allowed in
prompt override programs.

78 The parameter s not displayved untl Fe=All
parameters is pressed. Once displaved, it is
inputcapable. The command default is sent to the
CPT unless the value displaved on the parameter is
L'll.'IIIIL',l'L'l.

T The parameter i= not displaved until PO=All

parameters is pressed. Once displaved, it is not
input-capable. The command default is sent to the
Cre
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team

environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,

such as mainenance of an application. The RSE leverages the

Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see

the information of. Team sharing is done using the Eclipse team

support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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Support Labels and Comments

i@ Copy Source File (CPYSRCF) x|

Label:

QRPGLESRC Mame |
ECLIPSTEST
QRPGLESR.C
CACHECOPYL
CACHECOPYZ
CACHECOPYZ
*REPLACE

Data base source file:

Library: Mame

To File: Marne

Library: Mame

From member: Mame, generic®

To member or label: Mame

Replace or add record.
Source update optiog?

R

add |

[ =

Camment:

NEW! -

™ advanced I all Parameters [T Keywords
CPYSRCF FROMFILE(ECLIPSTEST/QRPGLESRC) TOFILE{CACHECOPY 1 /QRPGLESRC) FROMMER{CACHECOPYZ) ;I
TOMBR{CACHECOPYZE)
=
- o I Restore defaults | Cancel I
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team
environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,
such as mainenance of an application. The RSE leverages the
Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see
the information of. Team sharing is done using the Eclipse team
support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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Error Checking for CL built-ins functions

'@ Remote System Explorer - LKO2ZZ6W.R o ] 4|
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CELLEZ . *pgm.chlle a8 =
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Command [Mormal =] [Ese  1F (asEP *EQ MOME) CHEvAR BMRESP'E | Prompt... | Run
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We see that with the RSE you will be creating connections, filter
pools, user defined actions and compile commands. In a team
environment, we might wish to share some or all of this information to
save the effort of each team member having to redundantly create
them. This is especially for team members working on a shared task,
such as mainenance of an application. The RSE leverages the
Eclipse team support to enable this.

The first order of business for effectively enable team support is to
allow delineation between "team" information and "private"
information per developer. The RSE enables this by using profiles.
Every bit of information you create in the RSE is owned by a specific
profile, and each developer decides which profiles they wish to see
the information of. Team sharing is done using the Eclipse team
support, which uses a central repository, and a "synchronize" action
to synchronize individual developer's information with the repository.
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Additional Information

» homepage:
http://ibm.com/software/awdtools/iseries
Select Library link for Labs, Tutorials, Presentations

" newsgroup:

news://news.software.ibm.com/ibm.software.websphere.code400

=email distribution list:

“This ils th(le Websphere Development Studio Client for iSeries (WDSCI-L)
mailing list
To postga message email: WDSCI-L@midrange.com
To subscribe, unsubscribe, or change list options,
visit: http:/lists.midrange.com/mailman/listinfo/wdsci-|
or email: WDSCI-L-request@midrange.com
Before posting, please take a moment to review the archives
at http://archive.midrange.com/wdsci-l.”

y 7 Al
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We hope this presentation helped you understand more about Development
Studio Client iSeries application development tools. We started with an
overview of our strategy for iSeries application development tools, went onto
review the Remote System Explorer, the perspective for iSeries programmers
to maintain and develop iSeries applications and explained how to extend
RSE to include your own iSeries application development tools.
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Legal information
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= This presentation is a collaborative effort of the IBM Toronto iSeries
Application Development presentation team, including work done by:

Phil Coulthard, George Farr, Inge Weiss, Claus Weiss, and Don
Yantzi

Disclaimer:

= The information contained in this document has not been submitted
to any formal IBM test and is distributed on an as is basis without
any warranty either express or implied. The use of this information
or the implementation of any of these techniques is a customer
responsibility and depends on the customers’ ability to evaluate and
integrate them into the customers' operational environment. While
each item may have been reviewed by IBM for accuracy in a specific
situation, there is no guarantee that the same or similar results will
result elsewhere. Customers attempting to adapt these techniques
to their own environment do so at their own risk.

ReProduction:
» The base presentation is the property of IBM Corporation.

Permission must be obtained PRIOR to making copies of this
material for any reason.
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Some information addresses anticipated future capabilities. Such information is not intended as a definitive statement of a commitment to specific levels of performance, function or delivery schedules with respect to
any future products. Such commitments are only made in IBM product announcements. The information is presented here to communicate IBM's current investment and Gevelopment actvities as a good faith
effort to help with our customers' future planning

Performance is based on meastrements and projocions using standzrd BM benchmarks, n. contrlled envionment. T actual ivoughput or parformance that any user wilexperience willvary deperding upon
considerations such as the amount of mulfiprogramming in the user's job stream, the /O configuration, the storage configuration, and the workload processed. Therefore,
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